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1. Translating the Virtua Client and 

Virtua Profiler 

 
Most of the language strings that appear in the Virtua client and Virtua Profiler, such 
as messages, window titles, labels, buttons, menu items, and tooltips, are stored in the 
Virtua language table, which contains identifying information and all the translations 
for each string. Using the Virtua Language Editor, which you must install separately, 
you can translate and customize the text strings that appear in both your Virtua client 
and Virtua Profiler interfaces. This guide describes the use of the Virtua Language 
Editor. 
 

1.1 Introduction 

 
Each version of the Virtua software includes two new, updated language table files: 
vlang.db and plang.db: 
 

 The vlang.db file stores all the language strings used in the current version of the 
Virtua client. 

 The plang.db file stores all the language strings used in the current version of the 
Virtua Profiler.  

 
Both files reside in the /DBTables/Language directory of the Virtua client 
installation. 
 
The Virtua Language Editor is an easy-to-use interface to the language tables so that 
you can conveniently and efficiently edit and translate the language strings in both the 
Virtua client and Virtua Profiler. 
 

Note: If you want your translated text strings to appear in the general distribution of 
the Virtua client and Virtua Profiler, you will need to send your edited language table 
files (vlang.* and plang.* files) to Innovative for incorporation into the software. 
Innovative will make every effort to incorporate your latest translations into the first 
build that is created after we receive your files. Innovative will continue to use existing 
vlang.* and plang.* files in current builds until we receive updated files from 
translators. 
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2. Launching the Virtua Language 

Editor 

 

Important: If you are using Windows Vista or Windows 7, you will need to execute 
the Language Editor as administrator. 

 
To launch the Virtua Language Editor, 
 
1. On your Windows taskbar, click Start. 
2. Choose Programs/VTLS/Language Editor. 
 

The Virtua Language Editor window appears. Initially, the window is empty, 
except for a menu bar, toolbar, and status bar.  

 
 

 

Figure 2-1. Virtua Language Editor Window - No Table Loaded 

 
To begin an editing session and to enable the options on the menu bar and toolbar, 
you will need to open a language table using the Open Table toolbar icon or the File 
menu option.  
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2.1 Aspects of the Toolbar 

 
The Virtua Language Editor toolbar offers one-click access to common functions.  
 
 

 

Figure 2-2. Virtua Language Editor Toolbar 

 
Before you open a table in the Virtua Language Editor, only one of the eight icons is 
active: Open Table. After you open a language table, all eight icons become active. 
 

Hint: Each function that appears on the toolbar is also available from either the File 
or Edit menu. 

 
The Virtua Language Editor toolbar offers the following icons:  
 

   Open Table - Displays the Open Virtua Language Table dialog box, which 
lets you open an existing language table for editing.  

 

    Save Table - Saves your changes to the current language table, including any 
and all language versions. 

 

   Cut Text - Copies the selected text to the clipboard and deletes the selection.  
 

   Copy Text - Copies the selected text to the clipboard.  
 

   Paste Text - Pastes the text that is currently saved to the clipboard.  
 

   Select Language - Lets you choose the language a) into which you want to 
translate the current language table or b) that you want to edit in the current 
language table. 
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   Find - Displays the Find Dialog window, which lets you find a string in any 
field in the language table. 

 

   Replace - Displays the Replace Dialog window, which lets you find and 
replace a string in the [Language] column of the language table. 

 

2.2 Opening a Language Table 

 
To open a language table in the Virtua Language Editor, 
 

1. On the toolbar, click Open Table . 
 

The Open Virtua Language Table dialog box appears. 
 
 

 

Figure 2-3. Open Virtua Language Table Dialog Box 

 
2. Navigate to the subdirectory that holds your language table. Language tables have 

the file extension *.db.  
 
3. Select the language table (either for the client or Profiler) you want to view and 

edit, and then click the Open button.  
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Hint: The language table that the Virtua client uses is always vlang.db, and the 
language table that the Virtua Profiler uses is always plang.db. 

 
The Virtua Language Editor window appears, displaying the contents of the 
language table that you selected.  

 
 

 

Figure 2-4. Virtua Language Editor (vlang.db Table Loaded) 

 
For the purposes of this guide, we will use screen captures from the vlang.db language 
table only. 
 

2.3 Getting Oriented 

2.3.1 About Language Table Columns 
 
The language table contains six columns. The only column you can edit is the one on 
the right, the [Language] column, where [Language] is your currently selected language. 
If your currently selected language is English, the column labeled English will be 
empty because English is the default text of the language strings as displayed in the 
Native column. 
 
 The read-only columns are useful for string identification and for use as search criteria 
in Find and Replace searches. 
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 Index - Specifies the unique ID number of the language strings. Index numbers 
can also be used to help you identify language strings in the Virtua client.  

 Form Name - Offers a general description of the type of window on which a 
language string appears.  

 Component Name - Specifies an object in the client, such as a button, menu 
item, or title bar, on which a particular language string appears.  

 Property Name - Classifies language strings by type. This column is read-only. 

 Native - Specifies the default text of the language strings.  

 [Language] - Specifies your current editing language and displays all the 
translations that currently exist for the language. This is the column in which you 
actually edit and/or translate language strings.  

 

2.3.2 About Version Stamps 
 
To help you keep track of multiple versions of a language table, each vlang.db and 
plang.db file includes a version stamp, which indicates the version of the associated 
language table and the build date of the software. Version stamps can be useful, 
especially if you store older versions of the language tables to merge with new tables.  
 
The Version Stamp label appears in the Component Name and Native columns in the 
first row of each language table. The version stamp itself appears in the Property 
Name column. You can translate the label Version Stamp. 
 
 

   

Figure 2-5. Virtua Language Editor Window (Version Stamp) 
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3. Identifying and Finding Types of 

Strings in the Language Table 

 
Language tables contain a variety of features to aid you in navigation and in finding 
specific language strings to edit and translate. The labels in the Form Name, 
Component Name, and Property Name columns offer information about the type of 
string found in the given row of the language table. The number in the Index column 
is a valuable element to use in a search for a particular string in the language table. 
 

3.1 Using “Window Elements” Labels to 

Locate Window-specific Strings 

 
Window Elements labels such as ITEM INFORMATION WINDOW ELEMENTS 
appear in the Native column throughout the language table. A Window Elements label 
serves as a heading for a group of language strings found on the specified window in 
Virtua.  
 
For example, in the Native column of Index 5536, the Window Elements label for the 
Item Information window is ITEM INFORMATION WINDOW ELEMENTS 
(NON-TRANSLATABLE LABEL). 
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Figure 3-1. Window Elements Label - Item Information Window 

 
The rows directly below the heading ITEM INFORMATION WINDOW 
ELEMENTS (NON-TRANSLATABLE LABEL) contain strings that are associated 
with the Item Information window in the Virtua client. 
 
Because Window Elements labels are easy to recognize, you can use them to find 
groups of language strings. Window Elements labels . . . 
 

 Are in all capital letters. This means that you can find them by performing a case-
sensitive Find search.  

 Contain asterisks instead of labels in the Component Name and Property Name 
columns. 

 Usually take the form [WINDOW TITLE] WINDOW ELEMENTS (NON-
TRANSLATABLE LABEL) where [WINDOW TITLE] is the default title of the 
window.  

 
While most language strings are grouped under the appropriate Window Elements 
label, some strings such as Message strings and Search Category strings are not. 
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3.2 Identifying Strings for Titles of 

Virtua Windows 

 
Right below a Window Elements label, you will usually find a row that contains the 
label FormCaption in the Component Name column. This row contains the string that is 
used as the title of a window in Virtua.  
 
For example, in the row containing Index 5537, the Component Name column 
contains FormCaption. 
 

  

Figure 3-2. List of Titles FormCaption 

 
Scan across that same row to the Native column to see the language string Item 
Information. This is the label that appears in the title bar of the Item Information 
window in the client. 
 
In general, all language strings contained in rows below a FormCaption label appear 
somewhere on that specified window in Virtua.  
 
Below is an example of the row containing the FormCaption List of Titles. 
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Figure 3-3. List of Titles and Skip Windows Strings 

 

3.3 Identifying Strings for the Virtua 

Main Window  

 
Most of the language strings that appear on the Virtua main window are grouped 
under the Form Name VirtuaMainForm and have the Window Elements label 
VIRTUA WINDOW ELEMENTS (NON-TRANSLATABLE LABEL). 
 

Note: The Virtua main window does not have a FormCaption. This means that you 
cannot translate the language string that appears in the title bar of the Virtua main 
window.  

Language strings that 
appear on the Skip 

window 

Language strings that 
appear on the List of 

Titles window 
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3.4 Identifying Strings for Tooltips and 

Menu Options on the Virtua Main 

Window 

 
The rows that contain the Form Name VirtuaMainForm hold the strings for tooltips 
and menu options. Strings for tooltips correspond to the label Hint in the Property 
Name column, and strings for menu options correspond to the label Caption in the 
Property Name column.  
 
 

 

Figure 3-4. Virtua Main Window Language Strings 
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3.5 Identifying Strings for Search 

Categories 

 
Language strings for search categories, which appear in the drop-down lists on the 
Search window in the Virtua client, are associated with the Form Name 
SearchTypesDataModule.  
 
 

 

Figure 3-5. Strings for Search Categories 

 

3.6 Identifying Strings for Diagnostic 

Messages 

 
The vlang.db language table contains a group of language strings with the Form 
Name DiagnosticMessageModule, which contains language strings for diagnostic messages 
that appear in the Virtua client.  
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Figure 3-6. Strings for Diagnostic Messages 

 
In this group of language strings, each Component Name uses the format 
Diagnostic[Number, where [Number] is the unique number that the system uses to 
identify the message.  
 
Because strings in this group are not identified with a descriptive Component Name, 
we recommend that you search for diagnostic messages by their Native string or by 
Index Number. 
 

Note: In addition to the DiagnosticMessageModule, an OldMessagesModule and a module 
called NewMessages also exist. The OldMessagesModule contains message strings for 
acquisitions, cataloging, OPAC, and circulation. These messages are still used, but 
because the message file grew too large, we created a NewMessages file. 
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3.7 Identifying Strings for Enumeration 

and Chronology Labels 

 
In the Virtua client, enumeration and chronology labels are displayed for each issue in 
the list box on the Full tab of the View Holdings record window.  
 
Enumeration and chronology labels also appear in the client on the Serials Check-in 
window. 
 
In the vlang.db language table, enumeration and chronology labels are associated with 
the Form Name SerialsValueStrings.   
 

 

Figure 3-7. Strings for Enumeration and Chronology 
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3.8 Finding Strings Using the Find 

Feature 

 
Once you are familiar with the types of labels and strings available in the language 
table, you can easily find a particular string using the Edit > Find feature.  
 
For example, if you want to find strings associated with enumeration and chronology 
labels in the client, use the Find feature (Ctrl+F) to search on SerialsValueStrings in the 
Form Name field. 
 

 
 
The Find function locates in the language table the first occurrence of the term you 
enter in the Find What field on the Find Dialog window. You can use the Edit > Find 
Again (F3) function to locate the next occurrence of the term. 
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4. Identifying Index Numbers of 

Language Strings in the Client 

 
To help you identify strings in the Virtua client and then find them in the language 
table, Virtua offers a special feature. The feature allows you to display the client 
interface with an index number next to each string or label. The index number 
corresponds to the index number assigned to that string in the language table. Once 
you know the index number of a string, you can use the Find feature to search for it in 
the language table. 
 
To view index numbers for the language strings in the Virtua client, 
 
1. On your Windows menu bar, click Start, and then choose Run. 

 
2. In the Open text box, type: “[path]\virtua.exe” -L INCONTEXT, where 

[path] is the full path to your Virtua executable. Click OK. 
  

Hint: You can also enable the -L INCONTEXT option by defining it in the 
Properties of your Virtua shortcut. To do so, type the following in the Target field 
on the Shortcut tab of the Properties window: 
 
"[path]\virtua.exe" -L INCONTEXT  

 
Where [path] is the full path to your Virtua executable.  

 
3. In the Virtua Connect to Server window, select a server, and click the Connect 

button.  
 

4. In the Virtua Access dialog box, type your username and password in the Virtua 
Access dialog box. 
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Figure 4-1. Virtua Access Dialog Box 

 
5. Click the OK button to display the Virtua main window. 

 
 

 

Figure 4-2. Language Strings Identified with Index Numbers 

 
As shown in the figures above, the -L INCONTEXT option displays a number next to 
each language string in the interface. The numbers are displayed as long as Virtua is 
running with the -L INCONTEXT option. If you change the language of the client via 
the Language function on the Options menu, the language changes, and the index 
numbers continue to appear. To remove the index numbers from the interface, you 
must relaunch the client without using the -L INCONTEXT option.  
 
The number that you see preceding each language string identifies the string by an 
Index Number. In the language table you can find that Index Number and thus the 
string that appears in Virtua.  
 
For example, in the Circulation pull-down menu is labeled 6490. In the language table 
the row containing Index 6490 displays the language string for the Circulation menu 
language string, &Circulation.  
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Figure 4-3. Virtua Language Editor Window - Language Table Displayed 

 

Note: The ampersand (&) symbol can be used to indicate that the letter following the 
symbol will be underlined when the string appears in the client. The underlined letter 
will serve as the shortcut key for that function or control, for example, Alt + C. When 
you are editing language strings in the Virtua Language Editor, always place the & 
before the letter that you want underlined.  

 
To find index numbers of language strings in the Virtua Profiler, follow the steps 
outlined above with regard to the Virtua client except that in the Open text box, type: 
“[path]\profiler.exe” -L INCONTEXT, where [path] is the full path to your 
Virtua Profiler executable. 
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5. Editing Language Strings 

 

5.1 Choosing the Editing Language 

 
When you have a language table open in the Virtua Language Editor, you can choose 
to edit the language strings in any language supported by Virtua. 
 
To choose the editing language, 
 

1. On the toolbar, click Select Language . 
 

  

Figure 5-1. Select a Language to Edit Dialog Box 

 
2. In the Select a Language to Edit dialog box, choose a language, and then click OK. 

 
In the language table, the label of the [Language] column changes to reflect the 
language that you selected. Any strings that have already been translated in that 
language will be displayed. 
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Figure 5-2. Polish Language Strings 

  

5.1.1 Standard Editing Functions Available 
 
The Virtua Language Editor offers the following standard editing functions for 
working with text in the [Language] column of the language table and in the Multiple 
Line Editor: 
 

 Copy 

 Cut 

 Paste  

 Delete 

 Undo 

 Select All 
 

Note:  

 The Delete function lets you delete translations from the [Language] column only. 
It does NOT let you delete entire language strings from Virtua. If you delete the 
translation of a string from the language table, Virtua will display the Native string 
in Virtua by default. 

 The Undo function undoes the previous editing action. Do not confuse the Undo 
function with the Restore function.  
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5.1.2 Restoring Language Strings 
 
The Restore function lets you restore an original translation to the [Language] column, 
as long as you have not saved any changes to that translation. When you use the 
Restore function, the Language Editor restores, for a single row, the translation that 
existed in the most recently saved version of the language table.    
 
To restore an original translation of a string, 
 
1. Navigate to any cell in the row containing the string you want to restore. 
2. Highlight any part of the row. 
3. On the menu bar, click Edit, and then choose Restore String. 

 
The original translation (i.e., the string that existed in the most recently saved copy 
of the language table before you edited it) is restored to the [Language] column.  
 

Note: You can restore strings only before you save changes to the language table.  

 

5.2 Tips and Hints for Editing Language 

Strings 

 

5.2.1 Using Button Sizing Tool 
 
The translation of a string is often longer than the default English string, and it may 
not fit the size of a button in the Virtua client. To help with this situation, the Virtua 
Language Editor provides two fields at the bottom of the main window that give you a 
reference to two standard button sizes (width 85 and width 100) used in the client.  
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Figure 5-3. Button Display Width xx  Fields 

 
You can display the translation of a language string in each of these Button Display 
Width xx fields to see how it would fit on an actual button of the given size.  
 
To display a translation in the Button Display Width xx fields,  
 

 Double-click the row containing a language string for which a translation exists. 
Let’s say that you choose to display the French translation of Cancel, which appears 
on a button on the Authentication Required window (Index #14) 

 

Note: A translation must exist for the string to appear in the button reference 
fields. If a translation does NOT exist, the fields will remain blank. 

  
The translated string Annuler appears in both Button Display Width xx fields. 
 

85 x 25 pixel 
button size 

100 x 25 pixel 
button size 
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Figure 5-4. Button Display Width xx Fields (Translations Displayed) 

 
As shown in Figure 5-4Figure 5-4, Annuler fits nicely in the Button Display Width 
85 field. 

 

5.2.2 Copying Native Strings to the [Language] Column 
 
To copy a string from the Native column to the [Language] column, 
 
1. Navigate to any cell in the row containing the desired string. 
2. Highlight any part of the row. 
3. On the Language Editor menu bar, click Edit, and then choose Copy Default Text. 
 

Virtua copies the string in the Native column to the [Language] column, replacing 
any translation already there. 

 

Cancel button 
translation: 85 x 
25 pixel button 

size 

Cancel button 
translation: 100 x 
25 pixel button 

size 
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5.2.3 Viewing Multiline Strings in a Single Cell 
 
When a long language string appears in the Native column or [Language] column, the 
cell displays as much of the string as possible based on the width of the column. You 
can adjust the width of the column to view the entire string. 
 
Language tables contain two types of long strings:  
 

 Continuous strings 

 Multiline strings (i.e., strings with line breaks) 
 
In the Virtua client, continuous strings appear as one continuous line of text. Multiline 
strings, however, are formatted to be displayed in more than one line of text. You can 
easily distinguish between these two types of strings in the language table. 
 
In the Virtua Language Editor, when a long string contains one or more line breaks, 
the breaks are indicated with the symbol #13#10. Below, as an example, we show 
some language strings for the drop-down lists on the Virtua Search window. 
 
 

  

Figure 5-5. Language Strings for Virtua Search Window 

 
Another example, below, displays a portion of the long language string for the Browse 
Help text box that appears on the Virtua Search window. Note the line break symbol 
#13#10 and the number 1. that are typed before the word Choose. 
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Figure 5-6. Strings for the Help on the Browse Tab 

 

 

Figure 5-7. Virtua Search Window - Browse Help 

 

5.2.4 Identifying Variables in Language Strings 
 
Some language strings in the Native column contain variables. You must NOT 
edit/delete the following variables: 
 

 %d - Represents a numeric variable.  

 %c - Represents a character variable. 

 %s - Represents a string variable.  
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When a language string contains a percent symbol followed by the letter d (%d), 
Virtua replaces that variable with a system-generated number. In the same way, the 
variable %c is replaced by a character, and the variable %s is replaced by a string.  
 

Note: In strings where the percent sign appears without an accompanying letter, you 
can edit the percent sign as it does not represent a variable.  

 

5.3 Workflow for Translating Strings 

without Line Breaks 

 
To translate and/or edit language strings without line breaks,  
 
1. Open the language table, and select the working language. 
 

The [Language] column displays the language you selected. Where no string 
translation is available, the corresponding cell in the [Language] column is blank.  

 
2. Navigate to the strings you want to translate or edit by scrolling through the 

language table or using the Find feature. 

 
3. Translate/edit the desired strings: 

 If a translation already exists, edit the text as needed in the appropriate cell in 
the [Language] column.  

 If a translation does not already exist . . . 
 Type a new translation in the appropriate [Language] cell. 

-OR- 
 Use the Edit > Copy Default Text option to copy the Native string to the 

[Language ] cell, and then edit it.   

4. Continue finding, translating, and editing language strings until you have made all 
the changes you wish. 

5. When you are finished translating, click Save Table  to save your work.  
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After you save your changes,  

 The translations will be available in the language table whenever you select that 
language in the Virtua Language Editor.  

 The translated strings will appear in the client when you select the 
corresponding language in Virtua.  

 The language strings that you have NOT translated will appear in the client in 
the Native language. 

 

5.4 Workflow for Translating Long 

Strings with Line Breaks 

 
 
The Multiple Line Editor gives you the ability to . . .  
 

 Break up long language strings into multiple lines. 

 Edit strings that already contain more than one line, such as the Help text on the 
Browse tab of the OPAC Search window.  

 
The Virtua client will display the strings exactly as they are formatted in the Multiple 
Line Editor. 
 

5.4.1 Accessing the Multiple Line Editor 
 
To open the Multiple Line Editor, 
 
1. Select or highlight the string or empty cell in the [Language] column that you want 

to edit. 
2. On the Edit menu, choose Multiple Line Editor (F2). 
 

The Multiple Line Editor window appears, displaying the selected Native string at 
the top of the window and the translation of that string (if appropriate) at the 
bottom. If a translation does not exist, the lower text box will be empty. 
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Figure 5-8. Multiple Line Editor Window 

 

5.4.2 Translating and Breaking Up Long Strings 
 
To break up a long language string in the Multiple Line Editor, 
 
1. If the lower text box does not already contain a translation . . . 

 On the Multiple Line Editor window, click the Copy Native button  (the 
top left button on the Multiple Line Editor window) OR simply begin typing a 
translation directly in the text box. 

2. If the lower text box already contains a translation, edit the translation in the box 

as desired OR click the Clear button  to clear the text.  
 

3. Use the Enter key on your keyboard to insert as many line breaks as desired in the 
translated string. 

 

Note: The way the translated lines appear in the Multiple Line Editor window is 
exactly the way the language string will appear in the Virtua client. 
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Figure 5-9. Multiple Line Editor Window (Long String) 

 
4. When you are finished, click the OK button. 

 
The Multiple Line Editor window closes. In the language table, the translation 
appears in the [Language] column. The line break symbol #13#10 will represent 
each line break you entered in the Multiple Line Editor. 
 
 

   

Figure 5-10. Translation with Inserted Line Break Symbol 
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Notice that the translation for Index 815 now contains the line break symbol #13#10.  
 

5.4.3 Using the Replace Function 
 

The Replace function  is an extension of the Find function. It lets you find one 
language string and replace it with another. The Replace function along with the 
Replace Again function (F4) is particularly useful for translating and editing multiple 
occurrences of a string or for finding and correcting typos. 
 

 

Figure 5-11. Replace Dialog Window 

 

Note: The Replace function searches for strings in the [Language] column only. 

 

5.5 Working with Date Stamps 

 
You can record the date the language table was last edited with a date stamp, which 
you can view in the About window in the Virtua client.  
 
Each vlang.db file contains a language string with the Component Name 
TranslationDateStamp. The corresponding cell in the Native column displays the label 
date, but that label is not displayed anywhere in Virtua. In order for the date stamp to 
appear in the Virtua client, you must type a date or other string in the [Language] 
column. 
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Figure 5-12. Virtua Language Editor (Translation Date Stamp) 

 
To create a date stamp for the edited language table,  
 
1. Locate the row containing TranslationDateStamp as the Component Name in the 

language table. 
2. In the [Language] column, type the string you wish to use as a translation date 

stamp.  
3. Save your changes to the language table. 
 

You can now view the date stamp on the About window in the Virtua client. 
 

Note: The About window displays the TranslationDateStamp language string that 
corresponds to the language that is currently selected in the Virtua client. If the 
language you have selected in the Virtua client has no corresponding 
TranslationDateStamp string in the Virtua Language Editor, then the date stamp will 
not display on the About window. 
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6. Managing Language Table Files 

 

6.1 Copying and Restoring Language 

Tables 

 
The Virtua Language Editor gives you a way to . . . 
 

 Make a copy of the language table to serve as a backup. 

 Undo all unsaved modifications you made during an editing session and revert to 
the last saved language table. 

 
We recommend that you make backup copies of your language tables for two reasons:  
 

 As a security measure.  

 As a record of your modifications to and/or translations of a language table.  
 
When you receive a new release of Virtua, you will want to use your backup copy to 
merge your customizations into the new language table that accompanies the software. 
 

6.1.1 Making a Backup Copy of a Language Table 
 
To make a backup copy of a language table, 
 
1. Open the language table you want to copy as a backup. 
2. On the menu bar, click File, and then choose Backup. 
 

The Backup a Virtua Language Table window appears. 
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Figure 6-1. Backup a Virtua Language Table 

 
3. Choose a subdirectory, and type a filename for your backup copy. 
 

Hint: For easy reference, include as part of the filename the version number of the 
language table as indicated by the Version Stamp. 

 
4. Click the Save button. 
 

Depending on the speed of your machine, the backup will take one to two 
minutes. 

 

6.1.2 Reverting to the Last Saved Copy 
 
To revert to the last saved language table, 
 

 On the File menu, choose Revert. 
 

 If you made changes since the last save, the software asks you if you really 
want to revert the table to its previous state and lose all changes. 

 
 If you have not made any modifications, the software prompts: “No changes 

made since last save.” 
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6.2 Merging Language Tables 

 
The Merge function of the Virtua Language Editor lets you merge the language strings 

of specific languages from an “old” language tableone you have already 

customizedinto a new, updated language table that Innovative has sent you. The 
Merge function gives you a way to incorporate your modifications and translations 
from a previous version of the Language Editor into a new release of the Language 
Editor. 

 

Important:  

 Before you begin to merge language tables, you should check the Version Stamp at 
the top of each one to make sure that you are merging the correct tables.  

 After you have merged the language table, you must close the Language Editor 
before you launch the Virtua client; otherwise, you will see an error message. 

 

To merge strings from an “old” table to the new table that accompanies the 
latest version of Virtua, 

  
1. Open the new language table. 
2. On the menu bar, click Utilities, and then choose Merge.  

 
The Merge Table Select window appears. 

 
 



Virtua Language Editor (v. 16.1)  35 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

 

Figure 6-2. Merge Table Select Window 

 
3. Click the Add Table button. 

 
The Open Virtua Language Table dialog box appears. 
 
 

 

Figure 6-3. Open Virtua Language Table Dialog Box 

 
4. Navigate to and select the source table (i.e., the “old” language table) you want to 

merge into the new language table. 
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5. Click the Open button. 
 

The Open Virtua Language Table dialog box closes. On the Merge Table Select 
window, the file path of the source table is displayed automatically in the Source 
Tables display box. 
 
 

 

Figure 6-4. Merge Table Select Window - Source Table Selected 

 
6. In the Selected Fields list box, select the check box next to each language you want 

to merge from the highlighted Source Table file into the table currently open in the 
Language Editor.  
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Figure 6-5. Merge Table Select Window 

 
7. To begin the Merge process, click OK.  
 

Virtua merges your “old” language strings into the new language table. The 
amount of time required for the merge process varies, depending on the number of 
languages you are merging. 
 
After the merge, you will want to edit any new strings that have been added to the 
new version of Virtua.  

 

Note: In rare cases, the Form Name, Component Name, or Property Name associated 
with a language string will be changed for the new version of the Language Editor. If 
this occurs, your translation for that string will not appear in the language table after 
the merge. The cell will be blank. To complete the table, re-translate the string. 
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6.3 Exporting Language Tables to UTF-

8 Text Files 

 
The Virtua Language Editor offers an option that lets you export the current language 
table to a delimited text file.  
 

Note: One use of the exported language table file is to serve as input for 
AddDiagnosticText.exe, an executable that translates error codes that appear in 
vload’s Detailed Processing Summary (see the Virtua Record Loading User’s Guide for 
details).  

 
To export the current language table to a delimited text file, 
 
1. On the Language Editor menu bar, click File, and then choose Export.  

 
The Export dialog box appears. 
 
 

 

Figure 6-6. Export Dialog Box 
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2. In the Output File Name, specify the path and name of the output file. To do so,  

 Type the path and name of the file in the text box. 
-OR- 

 Click  to browse directories for a place to save the new file. 
 

3. In the Delimiter area, specify a delimiter for the output file (i.e., the character that 
will be used to separate values in each row of the text file). To do so,    

 Select the Vertical Bar, Tab, or Comma radio button to use that character as a 
delimiter.  
-OR- 

 Select the Other radio button, and then type the one-character delimiter of 
your choice in the text box.  

 
4. In the Record Range area, specify which rows of the language table you wish to 

export. To do so,  

 Select the Export Entire Language Table radio button to export ALL the rows 
in the table.  
-OR- 

 Select the Select a Range to Export radio button, and then, using the number 
that appears in the Index column of the table, type the desired range in the text 
boxes. For example, to export rows 226-2500, type 226 in the first text box 
and 2500 in the second text box.  

 
5. In the Columns area, select the columns that you want to export. To do so,  

 Select the Export All Columns radio button to export all columns. 
-OR- 

 Select the Export Specified Columns radio button, and then in the list, select 
the check box next to each column that you wish to export.  

 
6. Click the OK button. 

 
The language table is exported to the text file that you specified.  
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7. Printing and Saving Language 

Tables 

 

7.1 Printing the Language Table 

 
To print the language table,  
 

 On the File menu, choose Print. 
 
The Print Preview window appears, displaying the language table in read-only 
format. 
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Figure 7-1. Print Preview Window 

 
From the Print Preview window, you can . . .  
 

 View the language table page by page. 

 Print all or part of the language table. 

 Save the language table in Quick Report format.  
 

7.2 Saving the Language Table 

 
After you edit or translate the language strings in the language table, you will want to 
save your work using the Save option or Backup option. Both options save all of the 
changes made to ALL languages. 
 



42  Virtua Language Editor (v. 16.1) 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

Note: You can save your changes at any time during your editing session. As a 
precaution, we recommend that you save your changes frequently. 

 
To save your translations and overwrite the current language table, 
 

 On the Virtua Language Editor toolbar, click Save Table . 
 
Your changes are saved. 

 
To save your translations without overwriting the current language table, 
 
1. On the menu bar, click File. 
2. Click Backup. 
3. Save the language table under a different filename. 
 

The current table with your modifications is saved as a “backup.” In this way, the 
Backup function serves as a “Save As . . .” function. 
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8. Appendix A – Changes in this 

Guide 

 

8.1 Changes for Version 16.0 

 
No changes were made. 
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